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QUESTION 1

You have created an editor named MyEditor, and you want it to be available to edit the text item Product_Description.
You can associate the editor with the text item by setting the Editor property of Product_Description to MyEditor. 

A. True 

B. False 

Correct Answer: A 

 

 

QUESTION 2

The Orders form, whose properties have not been changed from the default, has two non-base table text items to
display the sales representative\\'s first and last names. 

You want to ensure that entries made in these Items correspond to an existing employee, so you write a When-Validate-
Item trigger for the Sales_Rep_First_Name text item: 

SELECT LAST_NAME Into :last_name FROM employees WHERE first_name = :first_name; EXCEPTION WHEN
NO_DATA_FOUND THEN MESSAGE (\\'There is no sales rep by this name\\'); 

When you test the form and enter a first name that does not exist in the database, the message that you specified
appears, but the cursor goes to the Sales_Rep_Last_Name item. You want the cursor to remain in the
Sales_Rep__First Name item until a correct first name is entered. 

Also, as you continue to test the form, at times, the cursor does not leave the Sales_Rep_First_Name item after you
enter a name, but no error message appears. 

Which two things can you do to correct these problems? 

A. Add the code to handle the FORM_TRIGGER_FAILURE exception. 

B. Raise the FORM_TRIGGER_FAILURE exception. 

C. Add code to handle the TOO_MANY_ROWS exception. 

D. Raise the TOO_MANY_ROWS exception. 

E. Code an On-Error trigger. 

F. Code an On-Message trigger. 

G. Write a When-Validate-Item trigger for the Sales_Rep_Last_Name item. 

H. Move the code to a form-level When-Validate-Item trigger. 

I. Change the form\\'s validation Unit property to Record. 

Correct Answer: AC 

1Z0-151 Practice Test | 1Z0-151 Study Guide | 1Z0-151 Exam Questions                              2 / 14

https://www.leads4pass.com/1z0-151.html
https://www.leads4pass.com/1z0-151.html
https://www.leads4pass.com/1z0-151.html


https://www.leads4pass.com/1z0-151.html
2024 Latest leads4pass 1Z0-151 PDF and VCE dumps Download

A: FORM_TRIGGER_FAILURE Exception Triggers fail only when one of the following occurs: *An unhandled exception
*When you request the trigger to fail by raising the built-in exception FORM_TRIGGER_FAILURE This exception is
defined and handled by Forms Builder, beyond the visible trigger text that youwrite. You can raise this exception: 

* In the executable part of a trigger, to skip remaining actions and fail the trigger *In an exception handler, to fail the
trigger after your own exception-handling actions havebeen obeyedIn either case, Forms Builder has its own exception
handler for FORM_TRIGGER_FAILURE , which fails the trigger but does not cause an unhandled exception. This
means that you can fail the trigger in a controlled manner. 

C: When you use SELECT in a PL/SQL block, it\\'s important to make sure that exactly one row will always be returned
by your query. If more than one row is returned, the TOO_MANY_ROWS exception occurs. 

Note 1_ When-Validate-Item fires when Forms validates an item. 

Note 2: The scope of a trigger is determined by its position in the formobject hierarchy--that is, thetype of 

object under which you create the trigger. There are three possible levels that answer the"What 

Level?"question in the slide graphic:· 

Form level: 

The trigger belongs to the form and can fire due to events across the entireform.· Block level: The trigger belongs to a
block and can fire only when this block is the currentblock.· Item level: The trigger belongs to an individual item and can
fire only when this item isthe current item 

 

QUESTION 3

You create a Customers form by using wizards. When you test the form, you notice that you cannot the complete name
that is displayed in the Customer_Name text item. Which three tools can you use to correct this problem? 

A. Layout Editor 

B. Property Palette 

C. Data Block wizard 

D. Layout wizard 

E. Object Navigator 

F. Object Library 

Correct Answer: ADE 

D: Use the Layout Wizard to quickly lay out the items of a data block. The wizard displays the items in a frame on a
canvas and lays them out in one of several layout styles, which you can manually alter to your own specifications. You
can reenter the Layout Wizard after the initial creation of a frame, enabling you to modify an existing frame, even if it
was not created with the Layout Wizard. 

E: The Object Navigator displays all of the form elements, data blocks, menu items, user defined code libraries, built in
procedures and functions, and database objects (tables, views). 

The Layout menu has items that control objects on a form much in the way adrawing package does. Objects can be
resized, moved, painted and otherwisemanipulated using items on this menu. Incorrect answers: 
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B: The Property Palette enables you to set the properties of objects you create in form and menu modules. When you
select an object in an editor or in the Object Navigator, the Property Palette updates to show the properties of that
object. You can invoke additional Property Palettes as needed, to compare the properties of different objects. 

C: Data Block Wizard Use the Data Block Wizard to easily create or modify data blocks for use in your application. The
Data Block Wizard can be reentered after initial creation of the data block, enabling you to modify an existing data block,
even if it was not originally created with the wizard. 

 

QUESTION 4

View the Exhibit. 

You have defined the window, canvas, and text items shown in the Exhibit. What happens when click Run Form? 

A. The form runs with the cursor initially in TEXT_ITEM8. 

B. The form runs with the cursor initially in TEXT_ITEM9. 

C. The form does not compile until you move TEXT_ITEM8. 

D. The form does not compile until you move TEXT_ITEM10. 

Correct Answer: A 

 

 

QUESTION 5

You are planning the alerts that are needed for your Human Resources application. You wish to display the following in
alerts: 
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*

 A message to inform the user about being at the just record 

*

 A warning about a potential conflict with the data just entered 

*

 A message to display a validation error to the user 

*

 A warning that the salary is out of range and that asks whether the user wants to correct it 

You want the note symbol ( ) to appear on alerts that display only informative messages, the 

warning symbol to appear on messages where you will allow the user to continue despite some data problem, and the
alarm boll symbol to appear where the user will not be allowed to continue without correcting the situation that caused
the alert to be displayed. 

You want to define the minimum number of alerts possible and customize them at run time. 

Which alerts should you define? 

A. One Note style alert and caution style alert 

B. One Note style alert and one Stop style alert 

C. On Caution style alert and one stop style alert 

D. On Note style alert, one Caution style alert, and one Stop style alert 

E. Two Caution style alerts and one Stop style alert 

Correct Answer: D 

In this scenario we need three different kind of alerts. 

How to Create an Alert 

Like other objects you create at design-time, alerts are created from the Object Navigator. 

1.

 Select the Alerts node in the Navigator, and then select Create. 

2.

 Define the properties of the alert in the Property Palette. Here are the properties that are specific to an alert. This is an
abridged list. 
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Note: Alerts are an alternative method for communicating with the operator. Because they display in a 

modal window, alerts provide an effective way of drawing attention and forcing the operator to answer the 

message before processing can continue. 

Note 2: Potentially, you can create an alert for every separate alert message that you need to display, but 

this is usually unnecessary. 

You can define a message for an alert at run time, before it is displayed to the operator. This means that a 

single alert can be used for displaying many messages, providing that the available buttons are suitable for 

responding to each of these messages. 

Create an alert for each combination of: 

*

 Alert style required 

*

 Set of available buttons (and labels) for operator response For example, an application might require one Note-style
alert with a single button (OK) for acknowledgment, one Caution alert with a similar button, and two Stop alerts that
each provide a different combination of buttons for a reply. You can then assign a message to the appropriate alert
before its display, through the SET_ ALERT_PROPERTY built-in procedure. 

Reference: Oracle Forms Student Guide, How to Create an Alert 

 

QUESTION 6

Immediately after creating a button in the Layout Editor, what is true about the button? 

A. It is an iconic button. 

B. It has no functionality. 
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C. It is not mouse navigable. 

D. It is not keyboard navigable. 

E. It is in the control block by default. 

F. It is not enabled. 

Correct Answer: B 

 

 

QUESTION 7

Which statement is true about flexible code? 

A. It is designed for reuse. 

B. It typically includes hard-coded object names. 

C. It is more difficult to maintain. 

D. It is more difficult to write, so it decreases developer productivity. 

E. It is specific to a particular module. 

Correct Answer: A 

 

 

QUESTION 8

What happens when you click Run Form Debug in Forms Builder? 

A. The form runs on your local machine by using a debug executable client. 

B. The form runs in a three-tier environment by using the application server URL that you specify in runtime
preferences. 

C. The form runs in a three tier environment by using the [debug] configuration in the FORMSWEB.CFG file. 

D. The form runs in a simulated three-tier environment by using an applet viewer that is included with the product to
enable debugging. 

Correct Answer: B 

Directly from the class materials from Oracle: As in the case when you run a form from Forms Builder with the Run Form
button, the Run Form Debug button runs the form in a three-tier environment. It takes its settings from the Preferences
window that you access by selecting Edit > Preferences from the main menu and clicking the Runtime tab. 

 

QUESTION 9
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You have coded the following When Button Pressed trigger: 

EXECUTE_QUERY; 

MESSAGE (\\'Query executed on block\\'); 

MESSAGE (\\'click next to navigate the next record\\'); 

When the user clicks the button, how is the message "Query executed on block" displayed? 

A. as a system message on the status line 

B. as a system message in a system alert 

C. as a system message in an application alert 

D. as an application message on the status line 

E. as an application message in a system alert 

F. as an application message in an application alert 

Correct Answer: D 

This is a customized application message. 

You can also build messages and alerts into your application: 

* Application message: These are messages that you build into your application by using the MESSAGE built-in. The
default display is on the message line. *Application alert: These are alerts that you design as part of your application,
and issue to the operator for a response by using the SHOW_ALERT built-in. 

 

QUESTION 10

View the Exhibit. 

You have just created a new object library as shown in the Exhibit. You want the tabs to have descriptive names. 
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You cannot change the names of the default object library tabs, so you must create new tabs in order to have
descriptive names. 

A. True 

B. False 

Correct Answer: B 

 

 

QUESTION 11

View the Exhibit. 

The orders form contains two canvases. Orders_CV displays one order and all of its order items. Help-CV displays
context-sensitive help. 

When users invoke the help screen for the Customer_Id item, the help information obscures the Custormer_Id item, as
shown in the Exhibit. Users would like to be able to see both the item and its help information simultaneously. 

How can you move the help information to the right so that the Customer_Id item is visible? 

A. increase the Viewport X Position on the Help_CV canvas. 

B. increase the Viewport X Position on Canvas on the Orders_CV canvas. 
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C. Decrease the Width on the Help_CV canvas. 

D. in the Layout Editor for the Orders_CV canvas, select View > Stacked Views, and then select the Help_CV canvas.
Drag the Help_CV canvas to the right of the Customer_Id item. 

Correct Answer: A 

Note: Viewport X Position on Canvas, Viewport Y Position on Canvas property Description Specifies the location of the
view\\'s upper left corner relative to the upper left corner of the canvas. The size and location of the viewport define the
view ; that is, the part of the canvas that is actually visible in the window to which the canvas is assigned. Applies to
canvas 

 

QUESTION 12

Which setting of :SYSTEM.MESSAGE_LEVEL suppresses all system messages? 

A. 0 

B. 10 

C. 25 

D. 50 

E. You cannot use :SYSTEM.MESSAGE_LEVEL to suppress all system messages 

Correct Answer: E 

Controlling System Messages You can prevent system messages from being issued, based on their severity level.
FormsBuilder classifies every message with a severity level that indicates how critical or trivial the information is; the
higher the numbers, the more critical the message. There are six levels that you can affect. 

Note: Suppressing Messages According to Their Severity In a trigger, you can specify that only messages above a
specified severity level are to be issuedby the form. You do this by assigning a value to the MESSAGE_LEVEL system
variable. Formsthen issues only those messages that are above the severity level defined in this variable.The default
value for MESSAGE_LEVEL (at form startup) is 0. This means that messages of all severities are displayed. 

 

QUESTION 13

The Employees database table contains more columns than can be displayed at one time in a form. You create a data
block that uses all the columns. How can you enable users to interact with all the items and switch between them
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without scrolling or closing anything? 

A. Define multiple content canvases and display them in multiple modeless windows. 

B. Define multiple content canvases and display them in the same modeless window. 

C. Define multiple content canvases and display them in multiple modal windows. 

D. Define multiple content canvases; display one in a modeless window and the others in modal windows. 

E. This is not possible because items from a single block must be displayed on the same canvas and window. 

Correct Answer: D 

 

Note 1: 

The most common canvas type is the content canvas (the default type). A content canvas is the "base" 

view that occupies the entire content pane of the window in which it is displayed. You must define at least 

one content canvas for each window you create. 

Note 2: 

Modal and Modeless Windows in Oracle Forms 

A window in oracle forms is a container for all visual objects that make up a Forms application. You can 

create two different type of windows in oracle forms. Lets have a brief comparisons between these two 

types of windows. 

* 

Modal Window: A modal window is a restricted window that the user must respond to before moving the input focus to
another window. Modal windows: Must be dismissed before control can be returned to a modeless window Become
active as soon as they display Require a means of exit or dismissal 

* 

Modeless Window: A modeless window is an unrestricted window that the user can exit freely. Modeless windows: Can
display many at once Are not necessarily active when displayed Are the default window type 

 

QUESTION 14

View the Exhibit. 
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You have begun the process of integrating WebUtil into the Ordes form. What two additional steps must be completed
yet? 

A. Write a Pre Form trigger to register WebUtil JavaBeans. 

B. Attach the WebUtil PL/SQL library to the form. 

C. Subclass the webUtilConfig parameter from the WebUtil object library into the form. 

D. Define WebUtil events that the form listens and responds to. 

E. Move the WebUtil data block to the last position under the Data Blocks node in the Object Navigator. 

F. Move the WebUtil data block to the first position under the Data Blocks node in the Object Navigator. 

Correct Answer: CE 

Integrating WebUtil into a Form 

Step 1: Attaching the WebUtil Library (This has already been done in this scenario not B) To use the 

functions of WebUtil in a Forms application, you mustfirst attach the webutil.pll library to any module that 

will use the WebUtil PL/SQL API. Select theAttached Libraries node in the Orders form and click Create. 

This invokes the Attach Librarydialog box, in which you can browse to the location of webutil.pll 
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Step 2: Subclassing WebUtil Forms Objects (C) 

Part of the WebUtil utility is a set of Forms objects contained in webutil.olb . This object library contains an 

object group called WebUtil, which you can subclass into your form. 

E: A data block named WEBUTIL; ensure that this is the last block in the Navigator. 

Reference: Oracle Fusion Middleware 11g, Build Applications with Oracle Forms, Integrating WebUtil into a Form 

 

QUESTION 15

A user at a remote location reports a problem that occurs when the Orders; form runs and the user clicks the invoice
button. You are not able to reproduce the problem, so you decide to use remote debugging. 

The steps involved in diagnosing the problem are listed below, but they are ordered incorrectly. What is the correct
sequence of Steps? 

1. 

You set a breakpoint in the When Button-Pressed trigger for the invoice button. 

2. 

The user\\'s screen goes blank. 

3. 

The user reports the host and port to you. 

4. 

You uses the debugger to step through the code. 

5. 

The user clicks a button that calls DEBUG.ATTACH. 

6. 

You attach to the user\\'s process. 

7. 

You open the Orders.fmb file from which the running .fmx was generated. 

8. 

The user clicks the invoice button. 

A. 5, 3, 6, 7, 1, 8, 2, 4 

B. 8, 3, 6, 5, 4, 7, 1, 2 

C. 7, 1, 3, 6, 5, 1, 8, 4 
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D. 3, 6, 5, 7, 8, 1, 2, 4 

Correct Answer: A 
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